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1 Overview

Who can benefit from reading this document?
This document provides information on using the HP Mosaic Dynamic Personalization application within the HP 
SmartStream Designer product. HP Mosaic is designed for HP SmartStream Designer users that want to include 
variable images in jobs. Basic HP SmartStream Designer knowledge is required.

This version of HP Mosaic is included in the following HP SmartStream Designer software versions:

● HP SmartStream Designer 12 for Adobe InDesign CC2017, Mac or PC

● HP SmartStream Designer 21 for Adobe Illustrator CC2017, Mac or PC

This HP Mosaic version includes the new Position option.

HP Mosaic can be manually updated for HP SmartStream Designer 6.3 for Adobe InDesign CS6.

Introduction
HP Mosaic is a Dynamic Personalization option for HP SmartStream Designer. The application is a random image 
generator. It creates unique PDF files based on a template file (.txt) and one or more original vector PDF files. The 
vector PDF files should have square dimensions (equal height and width).

The application takes a vector PDF file as input (also known as a Seed file), and then generates a large number of 
variations on the file by transforming it — scaling, transposition, and rotation — randomly. The output are used 
as variable image assets in the graphic design of VDP jobs.

An HP Mosaic job includes a Seed Set, which is a group of one or more Seed files. The Mosaic image files that are 
output are created from these Seed files.

The output HP SmartStream Designer file can be a PDF or an HPD template file. HPD Template files can be used 
in the following products to produce output files in those products:

● HP SmartStream Composer version 3.0

● HP SmartStream Composer-Lite 3.0 or 3.0 SP1

● HP SmartStream Production Pro 6.0 or later

● HP PrintOS Composer

Figure 1-1  Example of one-vector PDF source file (Seed file) and 5 HP Mosaic varied output

ENWW Who can benefit from reading this document? 1



Provided the PDF source file is sufficiently complex, each variation created by the application is unique. The cover 
of this guide features a project created with HP Mosaic.

The HPD file can be created as HPD Rich or HPD Fast. See details in Creating an output file or HPD template file 
on page 27. HPD Rich is supported only with HP SmartStream Composer Server.
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2 Getting started with the Sample job

The following steps are the recommended first steps to use HP Mosaic.

1. Download HP Mosaic 2.0 Sample Job.zip and HP Mosaic 3.0 Sample Job.zip

These ZIP file is available on the My HP Indigo portal, HP SmartStream Designer page.

NOTE: HP Mosaic 3.0 Sample Job uses the Shuffle Spot Colors option that is available only with HP 
SmartStream Designer 11.4 for InDesign CC2015.4 or later.

a. Go to https://myhpindigo-int-pro.houston.hp.com/Technical/SmartStream/SSdesigner/Pages/
default.aspx.

b. Select HP SmartStream Designer for Adobe InDesign

c. Click Quick Links. Then click Dynamic Personalization and open the HP Mosaic link.

d. Locate the HP Mosaic Sample Job.zip files, and then download them.

2. Unzip the relevant HP Mosaic Sample Job.zip.

It contains a sample Adobe InDesign file, related files, and PDF source files for the HP Mosaic application
(Seed files). The figure illustrates the file structure.

Figure 2-1  HP Mosaic 2.0 Sample Job.zip file structure

Figure 2-2  HP Mosaic 3.0 Sample Job.zip file structure

NOTE: The HP Mosaic 3.0 Sample Job contains a Seed file with Spot colors. This job utilizes the 
Shuffle Spot Colors option.

3. Open the DesignerLinks folder, which contains a Mosaic folder and the template file (.txt).

4. Copy the Seed Files to the folder on the local computer where variable assets are stored to be used later
with other HP Mosaic jobs. Provided in this folder are 3 vector PDF Seed files for the Mosaic 2.0 Sample job
and 1 Seed file for the Mosaic 3.0 Sample Job.

NOTE: It is recommended to start working with HP Mosaic by opening the supplied sample job, reviewing 
its Image Channel definition, and then create your own jobs.
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3 Workflow

Workflow steps
1. Open an Adobe InDesign or Illustrator document.

2. Using the HP SmartStream Designer menu, select a database file that includes at least 1 field with numeric
data (whole numbers larger than zero, typically counters such as 1,2,3,...), and then define an Image
Channel.

3. Double-click the channel row in the Channels panel to open the Image Channel window.

Figure 3-1  Image Channel window

a. Select Dynamic Image from the Type dropdown list.

b. Select HP Mosaic from the Application dropdown list.

c. Select the preferred option from the Fitting dropdown list.

d. For the Images Path, select the path where the Seed files are located. The Images Path location in this
example, for PC, is C:\Mosaic. An example path for Macintosh is Macintosh HD:Mosaic
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e. Click Settings.

The Dynamic Personalization Settings window opens.

Figure 3-2  Dynamic Personalization Settings window

4. In the Dynamic Personalization Settings window for a new job, the Demo_template_file is selected by
default.

NOTE: The Demo_template_file is a protected file (locked). Use the Save As  button to save a copy of 

the template file to enable editing.

5. In the Mapping Variables pane, select a database (DB) file that contains numeric data (positive whole
numbers). Each number generates a unique HP Mosaic image.

6. To proceed with a workflow that does not use additional editing options, click OK to close the Image
Channel definition window. Without using the editing option, the job uses the Seed files that are related to
the supplied sample job. To replace the Seed file, to be your own graphic design, see Using HP Mosaic
editing options on page 7.

HP Mosaic Image channel indication

● HP SmartStream Designer for Adobe Illustrator: The HP VDP logo displays in the center of the channel.

● HP SmartStream Designer for Adobe InDesign: The channel indicator now includes the following
information.

– The HP Mosaic Template name

– An orange gear icon that indicates Dynamic Personalization
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Figure 3-3  HP Mosaic Image Channel for Adobe Illustrator (1) and InDesign (2)

7. Select the HP SmartStream Designer Preview panel to enable preview of the results.

Using HP Mosaic editing options
It is possible to edit the HP Mosaic parameters with the HP Mosaic Template Editor. The changes are saved in the 
HP Mosaic Template file (txt) that is associated with the job.

The following parameters can be edited:

● Add another Seed Set or duplicate an existing Seed Set and edit its content.

● Add, replace, or delete Seed files

● Edit the parameters of a Seed file.

Follow these steps to open the HP Mosaic Template Editor:

1. For a Dynamic Personalization Image Channel with HP Mosaic definitions, open the Image Channel window
which is already defined as a Dynamic Image/HP Mosaic channel.

2. Double-click the channel row in the channel panel.
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3. In the Image Channel window, click Settings.

The Dynamic Personalization Settings window opens.

Figure 3-4  Dynamic Personalization Settings window

4. To enable editing, click Save As  to save a copy of the original template file.

NOTE: The original template file is locked and cannot be edited.

5. If you created a new template file previously, click Load to browse for the file, and then select it.

6. In the Dynamic Personalization Settings window, click Edit.

The HP Mosaic Template Editor window opens.

Editing at the Seed Set level

The main HP Mosaic Template Editor window enables editing at the Seed Set level. A Seed Set is a group of 
individual Seed files.

In the HP Mosaic 2.0 Sample Job, the default template contains 1 Seed Set which contains 3 individual Seed files, 
Diamonds.pdf, Melting.pdf, and Explosions.pdf.
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Figure 3-5  HP Mosaic Template Editor - Main window

1 Range Displays maximum range for the number of combinations that can be created from the defined Seed 
Set. The range should accommodate the DB numbers. For example, a range of 1-100,000 can 
accommodate DB/Counter numbers of 1, 2, 3,…99,000, 100,000, but not 100,001 or higher.

2 Seeds Lists the Seed files included in the Seed Set.

3 Delete Set If multiple Seed Sets are defined for a given template, use this function to remove one or more.

4 Duplicate Set Use this function to create a copy of another defined Seed Set.

5 Edit Set Use this function to edit the settings for a defined Seed Set.

6 Add Set Use this function to add an empty Seed Set for which you will need to define parameters.

For any Seed Set, the Seed files and Range must be defined. The Range is the range of DB records for which the 
defined Seed files will be used to create Mosaic images.

For example, two Seed Sets could be defined for a given template as follows:

● Set 1:

– Range: 1–299,999
– Seed files: Melting, Explosions, Dragons, Diamonds

● Set 2:

– Range: 300,000–399,999
– Seed files: Bluish flowers, Bluish shapes
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Figure 3-6  HP Mosaic Template Editor - New Seed Sets

Note that the Range index of any added Seed Set starts with the value +1 of where the previous Seed Set ends.

If the DB file that contains the numeric data for the HP Mosaic channel is a simple counter (1,2,3,...350,000), 
then:

● For DB records 1–299,999, the Seed files in Set 1 are used to define Mosaic images.

● For DB records 300,000 and higher, the Seed files in Set 2 are used to define Mosaic images.

If the DB field contains non-counter numbers (such as ID numbers) and a number is within the range of 
1-299,999 (such as 123,456), then the HP Mosaic variation that is created for it is generated using the Seed files 
of Set 1.
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Editing Seed Set and Seed file parameters

Click Edit Set in the Mosaic Template Editor opens the Edit Set window.

Figure 3-7  Edit Set window

In the Edit Set, it is possible to define the parameters for both the Seed Set as well as the individual Seed files 
contained in the Set.

1. Define the Seed Set parameters.

● Set Name: Type a name for the Seed Set.

● Start Index: Define the first DB record in the Range for this Seed Set.

● End Index: Define the last DB record in the Range for this Seed Set.

● Set Description: Provide a brief description of the Seed Set for reference.

● Seed Path: This can be edited only in Seed Set level. Designate the directory location for the Seed
files.

After the Seed Set, parameters are defined, proceed to the individual Seed file parameters.

2. Select a Seed file from the Seed File dropdown list. Any Seed file that is available at the designated Seed
Path is available to select. Take note of the recommendations in Seed file design recommendations
on page 17.

3. Set the Minimum Scale and Maximum Scale values for the HP Mosaic image output.

The default values range from 1 (100%) to 10 (1,000%) enlargement.
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4. Set the Position: Select the Random radio button for the application to randomly select a different area/
portion of the Seed file for every variation. Select the Centered radio button to create the variations out of
the image’s central area only. The default value is Random.

In the following example, the same Seed file is used, Rotation is None, Minimum/Maximum Scale is 1 and
10. The difference between the HP Mosaic variations of the upper row and the lower row are the Position
option settings.

Figure 3-8  Seed file

Figure 3-9  Position: Centered

Figure 3-10  Position: Random

5. Set the Rotation. The available options are the following:

● None: No rotation to images to produce output.

● Free Rotation: Any angle rotation is allowed to produce output.

● Every [X degrees]: Specify the step angle to use for each rotation, e.g. Every 45°, by selecting a
value from the dropdown list.

6. The Shuffle Colors option is available for Seed files that are defined with Spot colors.
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For a Seed file defined with Spot colors, it is possible to do any of the following:

● Shuffle between the Spot colors.

● Replace Spot colors with a predefined set of different Spot colors.

● Replace up to 12 Spot colors with a user defined set of Spot colors.

To shuffle colors, do the following:

a. Select the Shuffle Spot Colors check box and click Edit.

b. In the Edit Spot Colors window that appears, HP Mosaic identifies the document’s Spot colors, if there
are any.

Select Spot colors to be shuffled by selecting the check boxes next to their names.

c. Select one of the following radio buttons:

● Shuffle selected colors – to shuffle selected colors among themselves.

● Replace with set colors – to replace the selected colors with a different set from the predefined 
list of 5 sets. Click the dropdown arrow icon  to see the list of the predefined sets.

d. For each selected predefined set, you can do one of the following:

● Use it as is.

● Edit one or more of its colors by clicking the Edit icon .

e. To create a new set of up to 12 Spot colors, click the Plus icon .
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f. In the Custom Set window that appears after clicking the Edit or Plus icon, you can edit a Spot color
set.

To edit a Spot color, click its colored square. In the RGB/CMYK window that appears, select the required 
color using the sliders and color patch.
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7. When defining a new Set, if 2 colors are defined, such as color1 and color6, then the HP Mosaic application 
automatically fills the colors between them (colors 2, 3, 4, 5) with different hue values from 1 to 6.

8. Add a Seed Description to summarize the settings or Seed file use, if necessary.

9. Add, Duplicate, or Delete Seeds as desired.

NOTE: If the same settings will be used for multiple Seed files in the same Seed Set, define the settings 
for one Seed, and then add additional Seeds with the Duplicate Seed option. This option copies all the 
defined settings so the only required update is the Seed Name.

10. (Optional) Add a Seed Description.

11. After the updates are complete, click OK to confirm the changes.

The next chapter provides further details and recommendations for creating Seed files and defining their 
HP Mosaic parameters.
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4 Seed file design recommendations

The following are recommendations to consider when defining Seed files to use in HP Mosaic jobs.

Seed file recommendations
File type

● Seed files are Vector PDF

● Any application that can produce Vector PDF output, e.g. Adobe Illustrator, can create Seed files

File size and weight

● Seed files must be square (equal height and width)

● Seed file size can be up to 3.0 MB. The smaller the file (in MB), the faster the create output file process is for
creating the HP Mosaic variations.

● For multiple use elements, use tools such as the Adobe Illustrator Stamp option to help minimize the file 
weight

Mode

● The color mode should be CMYK (not RGB) and can include Spot Colors if required

NOTE: The Shuffle Spot Colors option is enabled only for Seed files that are defined with Spot colors.

How to design the Seed files

● Use vibrant, contrasting colors

● To enable scaling up while preserving the Seed file design, use small design elements and thin elements,
e.g. add frames to elements

● Use chaotic patterns and “untidy” design, i.e. non-linear designs and not like a checkerboard

Optimize Seed file size in MB without reducing graphic complexity

● Reduce the vector points and if using Adobe Illustrator, use Adobe Illustrator’s Simplify command (Object >
Path > Simplify)

● Remove unneeded data and if using Adobe Illustrator, remove hidden elements in the PDF by selecting File
> Save as PDF, and then unchecking Preserve Illustrator Editing Capabilities

● Manually combine vector elements and diminish the vector points in the document with Adobe Illustrator’s
Pathfinder (Window > Pathfinder)

● If applicable, knock-out overlapping element’s using Pathfinder’s Merge or Trim tools

● The pattern must be vector

● The Seed file should be saved as Vector PDF
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Preview for Proofing

● Before creating the final PDF output file or HPD Template file, use HP SmartStream Designer’s Preview
option to review the output

NOTE: It is recommended to define only one Seed per Seed Set for the purpose of Preview and review, 
and then combine the individual Seeds later into a single Seed Set.

● Preview for about 10–20 records for each Seed to make sure that the enlargement percentage maintains
the look and feel of the design

HP Mosaic Scale and Rotate recommendations

Scale

The decision of how much to scale depends on the individual Seed file.

1. Example 1: The look and feel of a Seed file can be lost when large scaling is used. The nature of the Seed
can be lost as in the results in the following figure. The 600% and 800% scale results lose the effect of the
Seed file. The decision of the graphic designer in this case, based on Preview trials, might be to scale up to
4 (400%) times larger and no more.

Figure 4-1  Scale — Example 1

2. Example 2: Text in the Seed file is a consideration for scaling. Large scaling can result in not being able to
see the characters or words in each of the output files.

Figure 4-2  Scale — Example 2
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3. Example 3: Seed files that include thin lines (framing) enable larger scaling options while maintaining the
Seed’s primary characteristics. For example, in the following figure, review the results for 200%, 400%, and
800% scaling.

The graphic designer in this case might decide, based on Preview trials, to scale up to 8 (800%) times
larger.

Figure 4-3  Scale — Example 3

Rotate

The default rotation is for Free Rotation. However, some Seed file content might lose its context under rotation, 
e.g. written text. Adjustments to the Rotate setting can accommodate such content.

Preview tests can help determine when not to rotate or when to rotate in step increments of 90°, 45°, etc. This is 
a Seed design related decision and varies on a case-by-case basis. In the second example in the preceding 
section, no rotation was used to maintain the text orientation in the graphic(s).
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Creating a Seed file from a JPG image
The Seed file is a Vector PDF. In order to create a Seed file from a JPG image, the JPG must be vectorized (traced).

Follow these steps to trace a JPG image in Adobe Illustrator, and then convert it to an HP Mosaic seed file.

1. Create a square JPG file.

Figure 4-4  Square JPG example

2. Open the JPG file with Adobe Illustrator, click Select, and then select All.

3. Click the arrow next to Image Trace, and then select High Fidelity Photo from the Tracing Presets.

Figure 4-5  Image Trace - High Fidelity Photo
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4. Click Expand.

Figure 4-6  Expand button

Adobe Illustrator creates a vector image of the JPG graphic.

Figure 4-7  Vector image example

5. Open the File menu, and then click Save As.

6. Provide a File name, select Adobe PDF as the file type, and then click Save.

NOTE: Make sure that the Seed file size (in MB) does not exceed the recommended size. Refer to 
recommendations on how to Optimize Seed file size in MB in Seed file recommendations on page 17.

7. Use this new vector image as the Seed file to produce HP Mosaic output files.

Figure 4-8  HP Mosaic output examples
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5 Seed files Q&A

1. Why would I have 2 Seed sets?

If, as an example, you want to create 50,000 random images and the DB field selected for the HP Mosaic 
channel is a counter (1,2,3...50,000). The first 25,000 to be created from two seed files and the other 
25,000 from a third seed file. You can define two Seed sets. The first two Seeds are defined in one set, and 
then the third Seed is defined in the second Seed set.

Another case for having more than one Seed Set is if you want to change Seed parameters after production 
has already started. If you have more than one Seed Set, you can change the Seed parameters for future 
copies without impacting copies that were already processed should you need to reproduce them.

2. What if my numeric data includes repeated values?

With the Template parameters unchanged and the Seed settings unchanged, the same DB value defines 
the same image, that is, the same Mosaic variation.

3. How do I work with the latest HP Mosaic in HP SmartStream Designer 6.3 for Adobe InDesign CS6?

You need to manually upgrade Mosaic to 3.0. HP Indigo support will instruct you with the upgrade steps..

– SmartStream Designer 11 for InDesign CC2015: Upgrade to SmartStream Designer 12 for InDesign 
CC2017.

– SmartStream Designer 6.3 for Adobe InDesign CS6: Manually upgrade the Mosaic to 3.0. HP Indigo 
support will instruct you with the upgrade steps.

4. How to define an HPD for Rich PDF or for Fast PDF

When creating the HPD template file, in the HP SmarStream Designer for InDesign Pack Job window, mark 
it for the PDF Fast workflow by selecting the Include Fast Template option.

When creating the HPD template file, in HP SmarStream Designer for Illustrator it is always HPD Fast, with 
no option to change it.

To also include the Seed files in the HPD template file, also select the Include variable assets option in the 
Pack Job window. See the next chapter for further details on creating the HPD file.

5. What do I do to match the leading color of Seed files to another image channel’s colors?

In the following example, there are two HP Mosaic channels. The two channels have exactly the same 
settings, parameters, and the same DB field is selected for both channels. The only difference is the Seed 
files:

– Channel 1: Includes 3 Seed files with multiple colors and elements. The leading colors are green, 
black, and red.

– Channel 2: Includes 3 Seed files of solid colors in the same order of green, black, and red.

With the same Seed settings and DB field, the same selections and calculations are made for both of the 
channels for every record.

For example, for a specific record, if the “greenish” Seed is selected for Channel 1, the solid green is 
selected for Channel 2.
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Figure 5-1  Example: Matching colors across HP Mosaic channels
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6. If the HP Mosaic channel is a simple rectangle, how can I get it to selectively appear on parts of my design?

You can design elements that should appear above the HP Mosaic channel in different InDesign or
Illustrator layers. See the example job below, with Illustrator layers. The same database record is
previewed.

Figure 5-2  Preview option on, all layers are active

Figure 5-3  Preview option on, only HP Mosaic layer is active
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6 Creating an output file or HPD template file

Creating an output file
HP SmartStream Designer for Adobe InDesign

1. From the HP SmartStream Designer menu, select Create Job to create an output file.

2. From the Format dropdown list, select PDF.

3. Adjust other settings as needed for the HP SmartStream Designer workflow, and then click Create.

HP SmartStream Designer for Adobe Illustrator

1. From the HP SmartStream Designer menu, select Create Job to create an output file.

2. Adjust other settings as needed for the HP SmartStream Designer workflow, and then click Create.

Creating an HPD template file
An HP template file is necessary for any workflow that includes one or more of the following:

● HP SmartStream Composer Server

● HP SmartStream Composer-Lite

● HP PrintOS Composer

● HP SmartStream Production Pro Print Server version 6 or later, HPD submit workflow

● HP SmartStream Director

The HPD template file is sent to these other products. Follow these steps to create an HPD template file.

1. From the HP SmartStream Designer menu, select Pack and Submit. The Pack and Submit window opens.
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Figure 6-1  Pack and Submit window (in HP SmartStream Designer for InDesign)

Figure 6-2  Pack and Submit window (in HP SmartStream Designer for Illustrator)

● Include variable assets: Select this option to include variable assets from the Assets folder in the HPD
file. If selected, the HP Mosaic Seed files will be included in the HPD file.

If the files are not included, the location of the files must be defined manually in HP SmartStream
Composer, and then the files copied to the designated location.
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● Include Fast Template (in HP SmartStream Designer for InDesign):

– In SmartStream Designer for InDesign:

○ When this option is selected, the resultant HPD is HPD Fast.

○ When this option is not selected, the resultant HPD is HPD Rich.

NOTE: In SmartStream Designer for Illustrator, the HPD file is always HPD Fast.

– HPD Rich:

○ Is supported with HP SmartStream Composer Server only.

○ Can include any graphic design attribute for the variable data.

– HPD Fast:

○ Is supported by any workflow that includes one or more of the following (that accept HPD:

● HP SmartStream Composer Server

● HP SmartStream Composer-Lite

● HP PrintOS Composer

● HP SmartStream Production Pro Print Server version 6 or later, HPD submit workflow

● HP SmartStream Director

○ Is processed in a shorter time than HPD Rich but is limited in the graphic design of the
variable data.

○ An automatic preflight check generates a popup warning message if any design attribute
that is not supported with HPD Fast is used. The warning message notes in which
Personalization channel it exists.

– An HPD file created for HP Mosaic jobs can typically be HPD Fast and gain the faster
performance advantage of this format since the HP Mosaic channels are normally a plain
rectangle.

– For sending an HPD file to HP SmartStream Composer Server:

○ Both HPD Fast and HPD Rich are supported.

○ Select the Include Fast Template option for better performance (optional).

– For sending an HPD file to HP SmartStream Composer Lite, HP PrintOS Composer, HP
SmartStream Prodution Pro version 6.0 or later:

When using SmartStream Designer for InDesign, the Include Fast Template option must be
selected (required).

NOTE: Designer for Illustrator creates HPD files with the Include Fast Template option included. It is 
not an option in the UI as it is always ON.

2. Send the HPD file to HP SmartStream Composer Server, Composer-Lite, PrintOS Composer, HP
SmartStream Production Pro version 6.0 or later, or Director, and then continue the standard VDP
workflow.

An HPD file can be created to two destinations: to File or directly to HP PrintOS Composer. Full details of this
option are available in the CA439-07860 - SMS Designer 12 InDesign CC2017 New Features presentation.
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A Service and support

To obtain service, please contact the customer care center within your country/region:

Europe:

Belgium: +32 (0)2 626 4803

France: +33 (0)1 57 32 41 07

Germany: +49 (0)69 38 07 89 193

Ireland: +353 (0)1 656 9760

Italy: +39 02 69430637

Luxembourg: +352 (0)24 87 13 98

Netherlands: +31 (0)20 547 6870

Spain: +34 9 12757781

UK: +44 (0)84 5604 7435

APJ:

Japan: +81 (0)1 2085 5536

Singapore: +65 9891 1753

Distribution Channels (DC): +31 (0)20 654 5543

North America: 1-800-204-6344

Israel: +972 (0)8 938 1818

North America and 
Latin America

International Israel APJ

HP

Indigo Division

5555 Windward Parkway

Alpharetta, GA 30004

USA

HP

Indigo Division

Startbaan 16

1187XR Amstelveen

The Netherlands

HP

Indigo Division

Kiryat Weizmann

P.O. Box 150

Rehovot 76101

Israel

HP

Asia Pacific Pte Ltd

No.3 Tuas Link 4 #02-01

Singapore 637016
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Printing instructions
NOTE: To ensure a high quality print, use the CA494-25890_print.pdf version of this document.

COVER

Paper weight 250 g

Page size 8.27 x 11.00 in (21 x 27.94 cm)

Printing HP Indigo digital press

Simplex/duplex Front cover - duplex

Rear cover - simplex

Color Full color - high resolution

Coating Lamination - shiny front and rear covers

INSIDE PAGES

Paper weight 80 g

Page size 8.27 x 11.00 in (21 x 27.94 cm)

Printing HP Indigo digital press

Simplex/duplex Duplex

Color Full color - high resolution

Coating None

FINISHING

Stitch 2 saddle stitch on left side
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